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Prerequisites

• Ansys LS-Dyna installed as part of Ansys 2020R2 package (or later release)
• LS-PrePost installed as part of Ansys 2020R2 package (or later release)
• LS-Run installed as part of Ansys 2020R2 package (or later release)
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Tutorial #1
We will model a ball impacting a plate:

Plate
Dimensions: 200mm x 200mm x 0.1mm
Material: Steel
 density RO = 7.83e-6 kg/mm3
 Elastic Modulus E = 207 GPa
 Poisson’s ratio PR = 0.3

Ball
Dimensions : radius = 25mm 
Material: Steel
 density RO = 7.83e-6 kg/mm3
 Elastic Modulus E = 207 GPa
 Poisson’s ratio PR = 0.3
Ball will be modeled as a Rigid Body

Boundary Conditions
Plate is pinned supported (UX=0, UY=0, UZ=0, 
RX=free, RY=free, RZ=free) along all 4 outer edges

Initial Velocity
Ball Initial Velocity = 10mm/ms

Pinned support

Pinned support

Pinned support

Pinned support
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Units
LS-DYNA requires that the Units set used is consistent.
Definition of consistent units:

1 force unit = 1 mass unit * 1 acceleration unit
1 acceleration unit = 1 length unit / (1 time unit)^2
1 density unit = 1 mass unit / (1 length unit)^3

We will use the [kg-mm-ms-kN] units set in this tutorial. Consistent set of units for Steel
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Launch LS-Prepost

1.  Start > ANSYS 2020 R2 > LS-Prepost
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Step # Desciption

1 Create Geometry and Mesh We will create geometry/FE mesh of a Plate and a Ball

2 Boundary Conditions

3 Material Properties

4 Section/Element Properties

5 Assign Material and Section Properties to Parts

6 Contact

7 Initial Velocity

8 Analysis Time and Output Controls

9 Submit Analysis in LS-Run

10 Postprocess results in LS-Prepost

Steps
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Create Plate

1. Mesh > ShapeM > Entity: 4N Shell
2. Enter x, y, z values for P1, P2, P3, P4 as shown
3. Enter NxNo and NyNo as shown
4. Target Name: Plate
5. Create
6. Accept
7. Done

Note:
P1, P2, P3, P4 coordinates
when creating 4N Shell

x

y

P1
(-100, -100, 0)

P2
(-100, 100, 0)

P3
(100, 100, 0)

P4
(100, -100, 0)
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Create Plate

1.  Shell Plate will be created
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Create Ball

1. Mesh > ShapeM > Entity: Sphere Solid
2. Radius: 25
3. Density: 5
4. x=0, y=0, z=27
5. Target Name: Ball
6. Create



We Make Innovation Work
www.padtinc.com

Create Ball

1. Ball mesh will be shown:
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Create Ball

1. Reject (we’d like to change Mesh Density)
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Create Ball

1. Change Density to 10
2. Create
3. Accept
4. Done
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Create Ball

1. Ball mesh will be created:
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Save

1. Remember to Save regularly, because LS-Prepost may close or freeze 
unexpectedly.

2. File > Save As > Save Keyword As…
3. “Save Keyword” popup window will appear
4. Browse to desired folder
5. Specify name. Give it .k extension
6. Hit “Save”
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Steps
Step # Desciption

1 Create Geometry and Mesh

2 Boundary Conditions We will create a pinned support Boundary Condition for outer 
edges of the Plate.

3 Material Properties

4 Section/Element Properties

5 Assign Material and Section Properties to Parts

6 Contact

7 Initial Velocity

8 Analysis Time and Output Controls

9 Submit Analysis in LS-Run

10 Postprocess results in LS-Prepost
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Boundary Conditions

1. Model > CreEnt > Boundary > Spc
2. Switch radio button from “Show” to “Create”
3. Uncheck boxes: RX, RY, RZ
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Boundary Conditions

1. In Sel. Nodes dialog window select:
a) ByEdge
b) Prop

2. Hover mouse pointer over one of the outer 
edges

3. LMB (Left Mouse Button) click
4. This should select and highlight all nodes along 

this edge
5. Repeat Steps 2 – 4 for the rest of the outer edges
6. All nodes of the outer edges should be 

highlighted as shown.
7. “Sel. Nodes(200)” should show (200) meaning 

there are 200 nodes selected.

Note: see tip on next slide if you selected wrong nodes accidentally
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Boundary Conditions

1. If you selected wrong nodes accidentally:
a) Hover mouse pointer over that region
b) RMB click
c) This should unselect all wrong nodes
d) Two nodes that we need were also 

unselected

e) Select them back with LMB
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Boundary Conditions

1. Apply
2. Done

Each outer edge is fixed in X, Y, Z while is free to rotate in RX, RY, RZ.
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Step # Desciption

1 Create Geometry and Mesh

2 Boundary Conditions

3 Material Properties We will create Elastic material property for the Plate, and Rigid 
material property for the Ball

4 Section/Element Properties

5 Assign Material and Section Properties to Parts

6 Contact

7 Initial Velocity

8 Analysis Time and Output Controls

9 Submit Analysis in LS-Run

10 Postprocess results in LS-Prepost

Steps
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Material Properties

1. Model > Keywrd
2. Switch radio button from “Model” to “All”
3. Expand [MAT]
4. Double click on [001-ELASTIC]
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Material Properties

1. Click “NewID”
2. TITLE: Steel

3. Type values for RO, E, PR as shown
a) Density RO = 7.83e-6 kg/mm3
b) Elastic Modulus E = 207 GPa
c) Poisson’s ratio PR = 0.3

4. Accept
5. Done
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Material Properties

1. Under [MAT] scroll down to [020-RIGID]
2. Double click on [020-RIGID]
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Material Properties

1. Click “NewID”
2. TITLE: Rigid

3. Type values for RO, E, PR as shown
a) Density RO = 7.83e-6 kg/mm3
b) Elastic Modulus E = 207 GPa
c) Poisson’s ratio PR = 0.3

4. Accept
5. Done

Note:
Rigid material property will be assigned to the Ball.
Components for which deformation is negligible and stress is unimportant may be modeled as rigid bodies.
The elastic constants defined here are used for contact stiffness calculations. Thus, the constants should be reasonable.
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Step # Desciption

1 Create Geometry and Mesh

2 Boundary Conditions

3 Material Properties

4 Section/Element Properties We will create SHELL section property for the Plate, and SOLID 
section property for the Ball

5 Assign Material and Section Properties to Parts

6 Contact

7 Initial Velocity

8 Analysis Time and Output Controls

9 Submit Analysis in LS-Run

10 Postprocess results in LS-Prepost

Steps
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Section Properties / Element Formulation

1. Expand [SECTION]
2. Double click on [SHELL]
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Section Properties / Element Formulation

1. Click “NewID”

2. TITLE: Section Shell
3. Leave ELFORM = 2 (default, Belytschko-

Tsay element formulation)
4. Type 0.1 in [T1] field
5. Press Enter
6. T2, T3, T4 fields should auto update 

with 0.1 value
7. Accept
8. Done
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Section Properties / Element Formulation

1. Expand [SECTION]
2. Double click on [SOLID]
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Section Properties / Element Formulation

1. Click “NewID”

2. TITLE: Section Solid
3. Leave ELFORM = 1 (default, constant 

stress solid element formulation)
4. Accept
5. Done
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Step # Desciption

1 Create Geometry and Mesh

2 Boundary Conditions

3 Material Properties

4 Section/Element Properties

5 Assign Material and Section Properties to Parts We will assign created Material and Section properties to the Plate 
and Ball

6 Contact

7 Initial Velocity

8 Analysis Time and Output Controls

9 Submit Analysis in LS-Run

10 Postprocess results in LS-Prepost

Steps
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Assign Material and Section Properties to Parts

1. Switch radio button from “All” to “Model”
2. Expand [PART]
3. Double click on [PART]
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Assign Material and Section Properties to Parts

1. [1 Plate] part should be pre-selected
2. TITLE: Plate

3. Press [•] next to [SECID]
4. “Link SECTION” popup window will 

appear
5. Double click on [1 Section Shell]

6. Press [•] next to [MID]
7. “Link MAT” popup window will appear
8. Double click on [1 Steel]
9. Accept
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Assign Material and Section Properties to Parts

1. Switch to [2 Ball] part
2. TITLE: Ball

3. Press [•] next to [SECID]
4. “Link SECTION” popup window will 

appear
5. Double click on [2 Section Solid]

6. Press [•] next to [MID]
7. “Link MAT” popup window will appear
8. Double click on [2 Rigid]
9. Accept
10. Done
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Step # Desciption

1 Create Geometry and Mesh

2 Boundary Conditions

3 Material Properties

4 Section/Element Properties

5 Assign Material and Section Properties to Parts

6 Contact We will define contact between the Ball and Plate

7 Initial Velocity

8 Analysis Time and Output Controls

9 Submit Analysis in LS-Run

10 Postprocess results in LS-Prepost

Steps
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Contact

1. Switch radio button from “Model” to “All”

2. Expand [CONTACT]

3. Scroll down and double click on 
[AUTOMATIC_SURFACE_TO_SURFACE]
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Contact

1. Click “NewID”
2. TITLE: Contact Ball to Plate

3. SSTYP: 3
4. MSTYP: 3

5. Press [•] next to [SSID]
6. “Link PART” popup window will appear
7. Double click on [2 Ball]

8. Press [•] next to [MSID]
9. “Link PART” popup window will appear
10. Double click on [1 Plate]

11. Accept
12. Done
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Step # Desciption

1 Create Geometry and Mesh

2 Boundary Conditions

3 Material Properties

4 Section/Element Properties

5 Assign Material and Section Properties to Parts

6 Contact

7 Initial Velocity We will assign initial velocity to the Ball

8 Analysis Time and Output Controls

9 Submit Analysis in LS-Run

10 Postprocess results in LS-Prepost

Steps
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Initial Velocity

1. Select radio button “All” if it’s not selected

2. Expand [INITIAL]

3. Scroll down and double click on 
[VELOCITY_GENERATION]
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Initial Velocity

1. Click “NewID”
2. STYP: 2
3. Press [•] next to [NSID/PID]
4. “Link PART” popup window will appear
5. Double click on [2 Ball]
6. VZ = -10
7. Accept
8. Done
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Step # Desciption

1 Create Geometry and Mesh

2 Boundary Conditions

3 Material Properties

4 Section/Element Properties

5 Assign Material and Section Properties to Parts

6 Contact

7 Initial Velocity

8 Analysis Time and Output Controls We will specify total duration of simulation and output controls

9 Submit Analysis in LS-Run

10 Postprocess results in LS-Prepost

Steps
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Analysis Time

1. Select radio button “All” if it’s not selected

2. Expand [CONTROL]

3. Scroll down and double click on 
[TERMINATION]
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Analysis Time

1. ENDTIM: 10

Note:
ENDTIM = 10 means that we are modeling 
10 ms of simulation where Ball impacts a 
Plate, and bounces back (we’ll see that 10 
ms is sufficient for that)

2. Accept
3. Done
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Output Controls

1. Select radio button “All” if it’s not selected

2. Expand [DATABASE]

3. Double click on [BINARY_D3PLOT]
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Output Controls

1. DT: 0.1

Note:
DT defines the time interval between output 
states. 
In our case, there will be at least 100 states 
(because 10 ms/ 0.1 ms = 100) with results 
written to disc.

2. Accept
3. Done
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Title

1. Select radio button “All” if it’s not selected
2. Expand [TITLE]
3. Double click on [TITLE]

4. TITLE: Ball Impact on Plate
5. Accept
6. Done

This step is optional, but a good practice.
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Model Check

1. Click “Model Check” button 2. “Model Checking” popup window will appear
3. Make sure there are no Errors
4. Read Warnings, UnRef, UnDefined messages
5. Done

This step is optional, but a good practice making sure there are no errors before submitting a job in LS-Run.
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Save

1. [Ctrl + S] to save .k file
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Step # Desciption

1 Create Geometry and Mesh

2 Boundary Conditions

3 Material Properties

4 Section/Element Properties

5 Assign Material and Section Properties to Parts

6 Contact

7 Initial Velocity

8 Analysis Time and Output Controls

9 Submit Analysis in LS-Run We will submit a job (created .k file) in LS-Run

10 Postprocess results in LS-Prepost

Steps
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Submit Analysis in LS-Run

1.  Start > ANSYS 2020 R2 > LS-Run
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Submit Analysis in LS-Run

1. INPUT: browse to .k file location

2. NCPU: 1 (default)
a) Change to desired/available number of CPUs, 

if you’d like to speed up computation time

3. Check box to start LS-DYNA in a command prompt 
window.

a) Command prompt will display useful 
information during computations

4. Hit “Run”
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Submit Analysis in LS-Run

1. Command prompt window will display miscellaneous information

2. LS-Run window will display % completion (estimate)
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Step # Desciption

1 Create Geometry and Mesh

2 Boundary Conditions

3 Material Properties

4 Section/Element Properties

5 Assign Material and Section Properties to Parts

6 Contact

7 Initial Velocity

8 Analysis Time and Output Controls

9 Submit Analysis in LS-Run

10 Postprocess results in LS-Prepost We will plot Von Misses stress and animate results

Steps
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Postprocess Results in LS-Prepost

1. After LS-DYNA finished computations
2. Click “LS-PP” button to launch LS-Prepost and 

load the results file (d3plot) automatically



We Make Innovation Work
www.padtinc.com

Postprocess Results in LS-Prepost

1. Click on “Play” button to animate the results
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Postprocess Results in LS-Prepost
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Postprocess Results in LS-Prepost

1. Post > FriComp
2. In “Fringe Component” popup window:

a) Select “Stress” > Von Mises stress
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Postprocess Results in LS-Prepost
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Next Time…

Next time we will learn what is written to a .k file (LS-DYNA input/keyword deck file). How this file is structured, basic most 
important keywords. Therefore, stay tuned!
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